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Chapter 18
Detalls of the ISHIKAWA Environment

This chapter presents detailed information about and examples of all the operations
available in the ISHIKAWA environment. Some of the examples build upon the dia-
gram created in the tutorial on page 519.

Summary of Operations

To invoke the following context-sensitive operations, apply the specified action
(mouse event) to the appropriate hotspot, using the left mouse button:

Table 18.1.  Primary Operations

Operation| Mouse Event | Hotspot Page
Add Click Near the intended attachment point534
Edit Click Arrow tail 537

Move Click (to pick) | Arrow head
Click (to drop) | Near the intended attachment point540

Delete Double click | Arrow head 544
Resize Drag Arrow tail 546
Notepad | Double click | Arrow talil 557
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Part 4. The CAPABILITY Procedure

To invoke the following operations, make the specified selection from the appropriate
context-sensitive popup menu using the right mouse button:

Table 18.2. Secondary Operations

Operation Menu Selection Page
Swap Head or tail Swap 549
Balance Head or tail Balance 551
Hide Detail Background < Detail 558
Show Detail Background > Detall 558
Zoom Head or tail Zoom 561
Isolate Head or tail Isolate 562
Print Pull-down File > Save as> Graph 566
Save Pull-down File > Save as> Data Set 581
Save Pull-down File > Save as> Image .
Subset Head or tail Subset 572
Copy Head or tail Copy 563
Refresh Background Refresh .
Unsubset Background Unsubset 572
Unbalance Background Unbalance 551
Undelete Background Undelete 544
530
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Chapter 18. Summary of Operations

When applied to the appropriate hotspots, the following actions (mouse events) in-
voke these context-sensitive operations:

Table 18.3. Context-Sensitive Tools

SAS OnlineDocl]: Version 8

Hotspot Mouse Event Operation Page
Arrow Head Click Begin move 540
Double click Delete 544
Drag Resize 546
Popup menu Subset 572
Balance 551
Swap 549
Copy 563
Zoom 561
Isolate 562
Arrow Tall Click Edit 537
Double click Notepad 557
Drag Resize 546
Popup menu Subset 572
Balance 551
Swap 549
Copy 563
Arrow Click Add new arrow or 534
complete move operation 540
Window Background Click Drop (finish) pending action
Drag Drop (finish) pending action .
Popup menu Undelete 544
Unsubset 572
Unbalance 551
Show Detail 558
Hide Detail 558
Refresh
531




Part 4. The CAPABILITY Procedure

The File menu on the command bar can be used to control the following operations:

Table 18.4. File Menu

File > Description Page
New Start a new diagram 519
Open Open an existing diagram 582
Close Close the current window
Merge Merge in an existing diagram 563
Save as Data Set Save as a SAS data set 581
Graph Print using SAS/GRAPH software | 566
Image Save as an IMAGE, catalog entry | 568
Export as Bitmap-  File... Copy to a bitmap file 568
Customize... Export options 569

The Edit menu on the command bar can be used to control the following operations:

Table 18.5. Edit Menu

Edit > Description Page
Copy Copy the diagram to host clipboard| 568
Clear... Clear the window

532
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Chapter 18. Summary of Operations

The View menu on the command bar can be used to control the following operations:

Table 18.6. View Menu

View > Description Page
Ishikawa Settings  Palettes Line and color palettes 572
Background Color | Change window background
color
Save Attributes Save window attributes}
size, fonts and background
color
Balance Method Select a balancing style 551
Resize Method Select a resizing method 546
Primary Fonts. .. Font dialog for first 3 levels | 570
Secondary Fonts. .. | Font dialog for levels 4-10 | 570
Colors... Color dialog 571
Arrows. .. Arrow style dialog 579
Other. .. Style dialog 580
Refresh Refresh the window

The Help menu on the command bar can be used to control the following operations:

Table 18.7. Help Menu

Helpr> Description

SAS System Help SAS help system

Using This Window Ishikawa specific help
533
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Operations

This section provides details concerning the operations available in the ISHIKAWA

environment. The order in which the topics appear is the order in which the opera-
tions are typically encountered. Some of the examples in this section build upon the
diagram created in the tutorial.

Adding Arrows

You add an arrow by pointing with the mouse to the intended attachment point along
an existing arrow and clicking the mouse. You control the direction of the new arrow
by offsetting the mouse cursor a small distance away from the parent arrow on the
side where the new arrow is to appear.

For example, to add upper branches, you offset the cursor slightly above the trunk.
To add lower branches, you offset the cursor slightly below the trunk. Likewise, you

offset the cursor to the right of the branch to add a right-hand stem and slightly left
for a left-hand stem.

If a new arrow is not drawn as you intended (either positionally or directionally), you
can easily move or delete it. To delete a new arrow before you have entered any text,
click in the background. To move a new arrow before you have entered any text,
move the cursor to a new attachment point and click.

Once an arrow is drawn, you are immediately prompted for its label (note the hint,
Edit..., displayed on the message line and the appearance of the text cursor at the end
of the arrow). See “Labeling Arrows” on page 537, for details on the text editing
features of the ISHIKAWA environment.

A diagram can contain up to ten levels of detail, but the number of arrows is limited
only by the resolution and size of your graphics display.

Example
Continuing with the tutorial example from “Tutorial” on page 519, suppose that
you have obtained detailed information for each of the three major service areas,
which you want to display by adding stems to the branches of the diagram you pre-
viously created. If you closed the ISHIKAWA environment after saving the data set,
SASUSER.AIRLINE, you can easily restore the diagram by submitting:

proc ishikawa data=sasuser.airline;
run;

534
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Chapter 18. Operations

To add a stem to the left side of the branch labdledFlight Service position the
cursor so that it is just to the left of the point where you want the stem to attach.
Click the mouse. The new arrow (pending text) appears as follows:

W sAS H=] 3
File Edit View Tools Soluons Window Help
- Ishikawa-New =] 3

Pre-Flight Service Post-Flight Service

Quality
Air Trawel
Service

In-Flight Service

Edt.. v

Figure 18.1. Adding the Left Stem
Type the labeMealsand presfReturn| twice.

To add a stem to the right side of the same branch, position the cursor so that it is just
to the right of the attachment point. When you click the mouse, your window will
appear as follows:

W SAS M=l

Eile Edit View Tools Soluions Windaw Help

“Ishikawa-New M= B

Pre-Flight Service Post-Flight Service

Cuality
Aijr Tranel
Senvice

In-Flight Service

Edit v

Figure 18.2. Adding the Right Stem

535
SAS OnlineDocl]: Version 8



Part 4. The CAPABILITY Procedure

Type the labeFlight attendantson two lines and presReturn| to terminate text

entry.

Complete the diagram by adding the remaining stems shown in the following win-
dow:

W 5AS (O] x]

File Edt View Iook Soltions Window Help

- Ishikawa-New [_TO] =]

Pre-Flight Senvice Paost-Flight Service

Fares

Baggage

Boarding passes

Cluality
Alr Trawel
Bervice

Flight attendants

Meals

Entertainrment

In-Flight Service

Y

Figure 18.3. Stem-Level Diagram

Experiment further by adding several of the leaves shown in the following window.
Don't be concerned if some of the labels collide with each other. Later, you will learn
how to move and resize arrows.

W 5AS (O] x]

Fle Edt Miew Took Sollions Window Help

- Ishikawa-SASUSER.ISHDOC [_[O]x]

Pre-Flight Service Post-Flight Service

Nearby
Competitive

Farss Free Secure

upgrades

Undamaged

Advance purchase

discounts Baggage

Boarding passes
gp Delivered

Advance issue
CQuality
Air Travel

Aftentive Senvice

Flight
attendants

Ample
soft drinks
Courtious
heals
Movies
Hutritious
Entertainmernt

Magazines

In-Flight Service

Figure 18.4. Leaf-Level Diagram
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Chapter 18. Operations

Labeling Arrows
To edit the label of an existing arrow, click on one of the following areas:
e the label
¢ the arrow tail (if the arrow does not have a label)
¢ inside the box for trunk and branch labels

Use your keyboard to enter the text.

On hosts that support direct graphical text erittipe following functions are sup-
ported:

edit keys such dBack spacg, [Delete char, Delete line|, andReturn]

cursor navigation keys suchfa, [1], andi—|

the[insert] key to toggle between insert and overstrike modes
buffers to copy, cut, or paste text into and from external sources

Text entry is terminated whenever you prfggsurn| on an empty line or exceed the
maximum line limit for a label. Text entry is also terminated whenever you click the
mouse. This shifts focus away from the editing operation and to the new location.

Labels are restricted to 40 characters per line. The trunk label can have up to five
lines, and labels for other levels are limited to two lines.

You can split a line of text into two lines by pressing key anywhere
inside the line. Likewise, flow a line with the previous line of text by pressing the

key at the beginning of the line.

You can copy the contents of the paste buffer into a label using the PASTE command.
This can be helpful when the information for your diagram is available from another
source (a flat file, for example). Use the paste buffer to copy the information from
that source to your Ishikawa diagram.

Some hosts designate the right mouse button for pasting, some use control keys (like
ctrl-p), while others use a designated function key. For more details about using paste
buffers with the SAS System, consult the SAS companion for your host.

To paste text into a label, you must first select the label. For existing arrows, se-
lect the arrow, position the cursor where you want the text to appear, and then issue
the PASTE command. For new arrows pending text entry, simply issue the PASTE
command. Any text in the paste buffer that causes the label to exceed its limits is
truncated.

When your mouse has a paste key defined, instead of adding an arrow and pasting the
text in two operations, use thight mouse button to add the arrow. This action adds

*Devices such as the IBM3179 do not support the direct graphical text entry mechanism described
in these examples. Instead, a text entry window pops up whenever you select an arrow for editing. You
must edit the text for the arrow from the dialog box and close the text entry window before the diagram
is updated.

537
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a new arrow, automatically copies the label from the paste buffer, and terminates text
entry, in a single operation.

Example
In the following diagram, the branch label&tFlight Servicehas been selected by

clicking on the arrow tail. The arrow is highlighted with a narrow dotted line, and the
text cursor is positioned over the first character in the label.

W 5AS (O] x]

Fle Edt Miew Took Sollions Window Help

- Ishikawa-SASUSER.ISHDOC =] E3

Pre-Flight Service Post-Flight Service

CQuality
Alr Trawel
Service

[n-Flight &Nice

Edi..

Figure 18.5.  Selecting an Arrow for Editing
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Chapter 18. Operations

To change the label so that the wdsdrviceappears on a separate line, uselthg
or key to move the cursor to the space before the v@edrice as shown in the

following:

W SAS M= B
Fle Edit View Tools Soluions Window Help
“ Ishikawa-SASUSER.ISHDOC M=l B3

Pre-Flight Senvice Post-Flight Senvice

Quality
Air Trawel
Semice

| In-FlighService

Edt.. v

Figure 18.6. Using Cursor Keys
Now presgReturn| to split the text into two lines.

W SAS M=l

Eile Edit View Tools Soluions Windaw Help

- Ishikawa-SASUSER_ISHDOC == E

Pre-Flight Service Post-Flight Service

Cluality
Air Travel
Service

InFlight
|service
Edit v

Figure 18.7.  Splitting Text

Remember to delete the space precediagyicebefore pressinfReturn | to terminate
text entry.

539
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Moving Arrows

You move an arrow by picking up the arrow and dropping it at a new location:

e To pick upan arrow, position the cursor over the arrow head and click the
mouse. The arrow you selected will be highlighted with a narrow dotted line.

If the arrow is not highlighted, move the cursor closer to the arrow head and
repeat the click.

e To drop an arrow, move the cursor slightly to one side of the new attachment
point and click (just as though you are adding a new arrow).

When you move an arrow, all its descendants move with it.

To cancel a move after picking up an arrow, click in the background area of the
ISHIKAWA window.

Do not try to drop the arrow back into place by clicking on the arrow head a
second time.A double click on (or near) the arrow head deletes the arrow. To move
an arrow a short distance, move the cursor away from the arrow head before clicking

to drop the arrow. On some systems the cursor will change shape when you have
moved outside the context-sensitive area.

Example

As your diagrams develop, you will want to reposition arrows, either because of

errors or for aesthetic reasons. The following is an example of an Ishikawa diagram
that needs to be modified:

W 5AS (O] x]
Fle Edt Wiew Iook Sobdions window Help

- Ishikawa-SASUSER.ISHDOC

Pre-Flight Service

In-Flight Service Post-Flight Service

Entertainmgit
s

Boarding passes

Flight Baggage

attendants
vieals

CQuality
Alr Trawel
Service

Figure 18.8.  An Inelegantly Arranged Ishikawa Diagram

The diagram lacks balance, and some of the branches are too close, resulting in col-
lisions and clipping.
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Chapter 18. Operations

One way to improve the diagram is to move the branchPie-Flight Serviceoward
the center of the trunk. First select the arrow head for this branch.

W 5AS M=l
Eile Edit View Tools Soluions Windaw Help
- Ishikawa-SASUSER_ISHDOC == E

Pre-Flight Service In-Flight Service Post-Flight Service

Entertainmsbt

s

Baggage

- Boarding passes Flight

attendants

1] J——
Cluality
Air Travel
Service
Mo v

Figure 18.9. Selecting an Arrow to Move

Then move the cursor to a point just slightly above the trunk near the desired new
attachment point.

W SAS M= B
Fle Edit View Tools Soluions Window Help
“ Ishikawa-SASUSER.ISHDOC [ O[]

Pre-Flight Service In-Flight Service Fost-Flight Service

Entertainmeht

B s,

Baggage

Boarding passes Flight

attendants

P P ———————
Quality
Air Trawel
Senice
Move... 4

Figure 18.10. Locating the New Attachment Point
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Drop the arrow in place by clicking the mouse.

¥ 5A5
Fle Edt Miew Took Sollions Window Help

- Ishikawa-SASUSER.ISHDOC =] E3

Pre-Flight Service

In-Flight Service

Post-Flight Service

Entertainmgit

Fares

Baggage
attendants

CQuality
Alr Trawel
Service

Figure 18.11. Dropping an Arrow into Position

Next, you should reflect the middle branch to the lower half of the diagram to bal-
ance the diagram and eliminate the remaining collisions. Once you have selected the
branch, position the cursor slightly below the trunk near the desired new attachment

point.

¥ 5A5 [_ (O] ]
Elle Edit Yiew Tools Solutions Window Help

% Ishikawa-SASUSER_ISHDOC M=

Pre-Flight Service In-Flight Service Post-Flight Service

Entertainmgit

T
Fares

Bnard"rm passes Flight Baggage

attendants
Meals

Cluality
Air Trawvel
Service

Move:

Figure 18.12. Selecting an Arrow for Reflecting
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Chapter 18. Operations

Click the mouse to complete the reflection.

W SAS M= B
Fle Edit View Tools Soluions Window Help
“ Ishikawa-SASUSER.ISHDOC [ O[]

Pre-Flight Service Fost-Flight Service

Fares

Baggage

Boarding passes

Quality
Air Trawel
Senice

Flight
attendants

Entertainment

In-Flight Service

Figure 18.13. Reflecting an Arrow

Note that the stems are reflected with the branch and that their positions (relative to
the trunk) are preserved.

Finally, the stem labeled/lealsis incorrectly attached to the branch labelere-
Flight Serviceand should be moved to the branch labdiedrlight Service Once
you have selected the stem, move the cursor slightly left of the new attachment point.

¥ sas =

Fle Edit View Tools Soluions Window Help
“ Ishikawa-SASUSER.ISHDOC [ O[]

Pre-Flight Service Fost-Flight Service

Fares

Boarding passes Baggage

Quality
Air Trawel
Senice
Flight
attendants
Entertainment
In-Flight Service
i
Move... 4

Figure 18.14. Locating the New Attachment Point
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To complete the move, click the mouse.

W 5AS (O] x]
Fle Edt Wiew Iook Sobdions window Help

- Ishikawa-SASUSER.ISHDOC =] E3

Pre-Flight Service Post-Flight Service

Fares

Baggage

Boarding passes

CQuality
Alr Trawel
Service

Flight
attendants

Meals

Entertainmernt

In-Flight Service

Figure 18.15. Moving a Stem

Apply the same principles when moving an arrow to a new level (for example, to
elevate a stem to a branch) or a new diagram (when you have multiple ISHIKAWA
windows open).

Deleting Arrows

You can delete an arrow (with all its descendants) by moving the cursor over the
arrow head (attachment point) and double clicking. If you accidentally move the
cursor while double clicking, it is possible that the arrow will be moved instead of

being deleted. In that case, double click on the arrow head again.

You can undo a deletion by moving the cursor to a background area of the window
and using the right mouse button to selfiidelete] from the background popup
menu. Repeat the operation when you want to undo several deletions.

Once an arrow has been selected for deletion, you can cancel the pending operation
by moving the cursor to a background area of the diagram and clicking the mouse.

The ISHIKAWA environment does not allow you to delete the trunk. To clear the
window, selecfEdit ~|[Clear...| from the command bar. Then start a new diagram by
selectingFile > |[New..| or[File »|Open.. .

544
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In the following

Chapter 18. Operations

diagram, the branch label@bst-Flight Servicehas been selected

for deletion (note that the branch is highlighted):

W 5AS M=l
Eile Edit View Tools Soluions Windaw Help
- Ishikawa-SASUSER_ISHDOC == E

Fares

Pre-Flight Service

Post-Flight Service

Exitz

Boarding passes Baggage

Cluality
Air Travel
Service

Flight
attendants

Meals

Entertainment

In-Flight Service

Delete. v

Figure 18.16. Selecting a Branch for Deletion

Without moving the cursor, click on the arrow head a second time to delete the branch.
W 5AS HEE

File Edit Wiew Iools Soluions Window Help

“ Ishikawa-SASUSER.ISHDOC [ O[]

Fares

Pre-Flight Service

Boarding passes

Quality
Air Trawel
Senice

Flight
attendants

Meals

Entertainment

In-Flight Service

Figure 18.17.

Deleting a Branch
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To undelete the previous deletion, move the cursor to a background area of the win-
dow and use the right mouse button to sefléstielete| from the background popup

menu.

¥ 5A5 [_ (O] ]
Elle Edit Yiew Tools Solutions Window Help

% Ishikawa-SASUSER_ISHDOC M=

Pre-Flight Service

e, ]

Unsubset
Unbalance

> Detail

Fares ;
< Detail

Boarding passes Refresh

Cluality
Air Trawvel
Service

Flight
attendants

Meals

Entertainment

In-Flight Service

Undelete the most recently deleted arow 7

Figure 18.18. Undeleting a Branch

Resizing Arrows

You can resize an arrow by holding the mouse button down over the tail end of the
arrow and dragging the mouseAs you move the mouse, the arrow is represented
by a rubberband line, and a plus sigr) (s drawn to indicate the original position of
the arrow tail. The new length is determined by the position of the cursor when you
release the mouse.

To cancel a resize operation once you have depressed the mouse button, release the
button outside the ISHIKAWA window.

All non-horizontal arrows are constrained to have the same angle. You control the
angle by resizing a branch. That is to say, when you resize a leaf, its angle does not
change.

Use)View ©|Ishikawa Settings> |Resize Method>] to control the scope of the resizing
operation.

o resizes only the arrow being dragged.

¢ (Global resiz_es all the arrows gt that level to lengths that are proportional to
the arrow being dragged. This is the default.

o resizes all arrows at that level to the length of the arrow being
dragged.

*Some devices (such as the IBM3179) require you to define a drag key. For more details about
dragging on your system, consult the SAS companion for your host.
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When you resize an arrow, you also update the default size for all new arrows at that
level.

By default, global and uniform resizing applies to all the arrows at the level of the
arrow being resized. To restrict resizing to a specific subset of arrows, you can subset
them as follows:

e Move the cursor over the arrow head of an arrow to subset that arrow and all
its descendants.

e Move the cursor over the arrow tail of an arrow to subset only that arrow (and
not its descendants).

¢ Use the right mouse button to activate the popup menu.
e SelecfSubse .

On some hosts, shift-clicking on the arrow head or tail also subsets an arrow.

Subsetted arrows are indicated by underlined labels. Subsetting is a toggle operation,
so tounsubsetn arrow, repeat the preceding steps.

To unsubset all the arrows in the diagram, do the following:

e Move the cursor to a background area of the window.
¢ Use the right mouse button to activate the background popup menu.

° Selec )

Be sure to remove all subsets after you have finished modifying the diagram, since
remaining subsets can alter the focus of other operations.

See “Modifying Arrow Colors and Line Styles” on page 572, for more examples of
how subsets are used.
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SAS OnlineDocl]: Version 8



Part 4. The CAPABILITY Procedure

Example

Arrows that are too long can cause clipping and collisions, as illustrated in the fol-
lowing diagram:

¥ 5A5 [_[Ofx]
Elle Edit Yiew Tools Solutions Window Help
o Ishikawa-SASUSER.ISHPLANE

Pre-Flight Service Post-Flight Service

|
rarby gates Ou_\:k
Conwveniimplsning
Minirrurn departure times Baggage
connections Cluick SECUrity

‘ ticketindconnecting

anes bn:ﬁ;;z flight information
P Competitive Mearky

Frequentflier fares exits
coutesies Mdfttes accessible
oo ABkNSketed Cluality
Air Trawvel
Service
techanical .
Flight
Frompt aftendants
arrival
Meals
Cormfartable
seating
Prompt
departures
Entertainrment P

In-Flight Service

Figure 18.19. Before Resizing the Diagram
To resize the stems in the upper half of the diagram, proceed as follows:

e Subset the branch fdere-Flight Serviceby moving the cursor over its arrow

head and selectiri§ubsef .

¢ Do the same t®ost-Flight Service

e Shorten one of the subsetted stems by dragging its tail to the desired length.

» Remove all subsets by selectigsubsef .
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The results are as follows:

W SAS

Fle Edit View Tools Soluions Window Help

Chapter 18. Operations

=

- Ishikawa-SASUSER.ISHPLANE

Pre-Flight Senvice

MNearky gates .
Convenient

departure times

Cuick
ficketing

Minirnum
connections

Advance boarding Co

passes Cormpetitive

fares
Mo
overbooking

Freguentflier

courtesies Gates

Mechanical

Prompt
arrival

Comiortable
sealing

Entertainment

In-Flight Service

Quick
deplaning

flight infarmation

to non-ticketed

[H[=] B3

Post-Flight Service

Baggage
SECUtity

nnecting

MNearby
exits

accessible

Quality
Air Trawel
Senice

Flight
attendants

Meals

Prampt
departures

Figure 18.20.  After Resizing the Diagram

Swapping Arrows

Use the swap operation to interchange two arrows in a single operation instead of
using two move operations. Swapping has all the flexibility of the move operation;
parents, different levels, or arrows from

you can swap arrows that have different
different diagrams.

Like moving, the results depend upon wh
head or the arrow tail. When you select
arrows are interchanged.

Swapping is a two step operation.

e Move the cursor over the arrow head (tail) of one of the arrows to be swapped

ether you select the arrow from the arrow
the arrow head, the arrow and all its de-
scendants are moved. When you select the arrow tail, only the labels of the selected

and selegBwap| from the context-sensitive popup menu.

e Complete the swap by using the mouse to select the comparable end (head or

tail) of the second arrow.

To cancel a swap after you have selected the first arrow, click in a background area of

the diagram.

Example

To swap the branch labeldere-Flight Service(and all its descendants) with the
branch labeledPost-Flight Servicen the following diagram, move your cursor over
the arrow head of th@re-Flight Servicebranch and activate the popup menu using

the right mouse button. Selg8tvap| to begin the operation.

5
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¥ 5A5 [_ (O] ]
Elle Edit Yiew Tools Solutions Window Help
% Ishikawa-SASUSER_ISHDOC M=
Pre-Flight Service Post-Flight Service
Fares
Boarding passes Baggage
Cluality
I Ailr Travel
B Service
alance
EECEN Flight
Copy attendants
hiea  Zoom
Izolate
Entertainment
In-Flight Service
i
Swap bwo arows v
Figure 18.21. Swapping Two Arrows
To complete the swap, select the arrow head ofRb&t-Flight Servicdranch.
¥ 5A5 [_ (O] ]
Elle Edit Yiew Tools Solutions Window Help
% Ishikawa-SASUSER_ISHDOC M=

Post-Flight Service

| Pre-Flight Service
i

Exits
Fares

- Boarding passes

Flight
attendants

Meals

Entertainment

In-Flight Service

Baggage

Cluality
Air Trawvel
Service

Swap with

Figure 18.22.  Swapping Two Arrows (continued)
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Chapter 18. Operations

The completed diagram illustrates how the swap operation simplifies interchanging
two arrows.

W SAS M=l

Eile Edit View Tools Soluions Windaw Help

- Ishikawa-SASUSER_ISHDOC == E

Post-Flight Service

Pre-Flight Service

Exitz

Baggage Boarding passes

Cluality
Air Travel
Service

Flight
attendants

Meals

Entertainment

In-Flight Service

Figure 18.23. Completing a Swap

An alternative to swapping the arrows is to move them. However, moving arrows in
this situation requires more steps and tends to be more cumbersome than swapping.

Balancing Arrows

An Ishikawa diagram is said to lmlancedif the sub-arrows attached to each arrow
are equally spaced.

To balance the immediate descendants of an aagvall its descendantgroceed
as follows:

e Move the cursor over the arrow head.
¢ Activate the popup menu using the right mouse button.

e Selec{Balance] .

To balance only the immediate descendants of an arrow, s
popup menu for the arrow tail.

from the

You can restore the arrows to their original positions by doing the following:

¢ Activate the background popup menu using the right mouse button.

- SelectUibalanca
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The ISHIKAWA environment provides three alternative methods for balancing ar-

rows. Select one of the following choices from thgew | [shikawa Setting > |
[Balance Method>| menu:

o |Preserve order/side$ maintains the order and directions of the sub-arrows but
repositions them so they are evenly spaced.

o [Preserve order/alternate side$ maintains the ordering of the arrows but reposi-
tions adjacent arrows so that they appear on opposite sides. This is the default

° maintains the side on which the sub-arrows are attached then
spaces each side of the arrow independently.

Example

Consider the following unbalanced diagram:

W SAS

Fle Edt Miew Took Sollions Window Help

JS[=] S

- Ishikawa-New

[H[=] B3

Branch A

Branch D BranchE

Branch B

Branch C

Figure 18.24.  An Unbalanced Ishikawa Diagram
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To balance only the stems of the branch labé3eanch A move the cursor over the
arrow head and press the right mouse button.

W SAS

= E3
Eile Edit View Tools Soluions Windaw Help
“Ishikawa-New M= B
Branch A Branch D Branch E
1
2
3
4
5
—‘ Subset
| p— Swap
4 — | Copy
Zoom
Isolate
1
Branch B Branch C
Balance sub-amows v
Figure 18.25. Balancing a Branch
SelectBalance| from the arrow head popup menu.
W SAS H=] 3
File Edt Yiew Tools Soluions Window Help
- Ishikawa-New [_ O] %]

Branch A Branch D Branch E

Branch B Branch C

Figure 18.26. A Balanced Branch

Note that since the stems are without leaves, selecting either the head or the tail has
the same result.
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To balance only the five major branches in the preceding diagram without affecting
their stems, move the cursor to the tail end of the trunk and sBbtahce] from the

popup menu.
W 5a5 JS[=] S
File Edit View Took Solfions Window Help

- Ishikawa-New [_[O]x]

Branch A Branch C BranchE

Branch B Branch B

Y

Figure 18.27.  Balancing Only the Branches

To balance the entire diagram (from head to tail, so to speak), move the cursor to the
head of the trunk and selgBtlance] from the popup menu.

W SAS [_ O] x]

Elle Edit Yiew Tools Solutions Window Help

% Ishikawa-New [_T0[ =]

Branch & Branch C Branch E
| |

Branch & Branch B

Figure 18.28. Balancing the Entire Diagram

Note that the balancing method used here not only changes the spacing of the stems
but reflects them as needed to achieve a balanced appearance. You can control this
by specifying a balancing method, as illustrated by the next example.
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Example
The following diagram displays an unbalanced branch and a copy of that branch after
it was balanced using tlereserve order/alternate side$ balancing method:

W S5AS [_[O1x]
Eile Edit View Tools Soluions Windaw Help

“Ishikawa-New M= B

Original | Preser«e Orderfaltemate Sides

Figure 18.29. Preserving Order But Alternating Sides

Note that the stems remain in orddr&) from tail to head, but they now alternate
evenly across both sides of the branch. This is the default method used for balancing
arrows.
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Example
The following diagram displays an unbalanced branch and a copy of that branch after
it was balanced using tlreserve order/sides method:

W SAS [_ O] x]

Elle Edit Yiew Tools Solutions Window Help

% Ishikawa-New

Original Freserve Order/Sides

Figure 18.30. Preserving Order and Sides

Note that stemd-6 remain on the left, stemis-3 and7-8 remain on the right, and the
order from tail to head is stifll-8. However, the stems are now spaced uniformly.
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Example

The following diagram displays an unbalanced branch and a copy of that branch after

it was balanced using tifereserve side$ balancing method:

W SAS M=l

Eile Edit View Tools Soluions Windaw Help

“Ishikawa-New

Original Freserve Sides

Figure 18.31. Preserving Sides

Note that the stems on the le#t-g) are spaced uniformly, and the stems on the right
(1-3and7-8) are spaced uniformly. The two sides are spaced independently of each
other.

Notepads

Ishikawa (1982) and Kume (1985) advocate the display of quantitative information
with the arrows in an Ishikawa diagram.

In the ISHIKAWA environment, you can us¢otepadwindows to record or display
information associated with each arrow. To open the Notepad window, move the
cursor over the arrow tail and double click.

Ichikawa Motepad E3

Prompt arrival

DKl Eancell He]pl

Figure 18.32.  Ishikawa Notepad
Notes are limited to four lines of text with no more than 40 characters per line.

When you save your Ishikawa diagram, your notes are saved with the SAS data set.
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Later, when you retrieve your diagram, all the notes are restored.

You must close th&lotepadwindow before you continue working in the ISHIKAWA
environment.

Example
In the following figure, double clicking on thBrompt arrival stem reveals details
about prompt arrival times:

W 5AS (O] x]
File “iow Iook Solfions ‘Window Help
Ishikawa Notepad [ %]

Prompt arrival

[E105 Flights in January
35 Weather Delays

15 Traffic Delays

10 Ground Delays

M Cancel |

Connecions

Post-Flight Service

Cuick
deplaning
Baggage
SECUrity

ticketing Connecting

Advance boarding flight informstion

passes Competitive

MNearhy
fares

Fraguentflier exits

courtesies

Mo Gates accessible
overhoakin 1o non-ticketed Cluality
Air Travel

Service

Mechanical Flight

attendants

Prompt e

arrival
Meals
Cornfortable

seating Prompt

departures
Entertainmernt

In-Flight Service

Figure 18.33.  Using Notepads to Organize Details

Managing Complexity

A major advantage of the ISHIKAWA environment is that you can quickly organize
a highly complex diagram. However, not everyone may be interested in seeing all the
details—at least initially.

To increase the level of detail by one level, do the following:

e Move the cursor to a background area of the window, and use the right mouse
button to activate the background popup menu.

e Select> Detail]. On some hosts, you can press|thekey instead of using the
popup menu (as long as you are not editing text).

Each time you sele¢t Detail] from the background popup menu, the detail increases
by one level.

To reverse the process and decrease the level of detall, from the
popup menu, or press the| key.
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Example

You are making an online presentation about factors that influence the quality of air

travel service. The following diagram presents too many details to be a good starting
point for your audience:

¥ SAS H=] 3
File Edt Yiew Tools Soluions Window Help
= Ishikawa-SASUSER.ISHPLANE [_To[x]
Pre-Flight Service Fost-Flight Service
. i
MNearby gates Quick
/8 Convenient deplaning
WMiniraurm departure times Baggage
connections Clgick SECuUrity
Advance boarding ticketing Connecting
flight information
passes Competitve Nearky
Frequert flier fares exits
couttesies MNa Gates accessible
overbookin to nonicketed Quality
Air Trawvel
Attentive Helpful Full-size Ample Service
Flight pillows leg room
attendants Comfortable
Comfortable Courteaus seating
cabin temp Clean fmple
Mechanical Choice of  Elbow room
entrees
Smoothride  Smooth
Magazines Janding Meals
Ententainment Mutritious  Ample
Headsets X X shacks
In-Flight Service
i
4
Figure 18.34.  Highly Detailed Ishikawa Diagram
A better way to begin is by displaying only the trunk and branches.
¥ SAS H=] 3
File Edt Yiew Tools Soluions Window Help
“ Ishikawa-SASUSER.ISHDOC M=l B3
Pre-Flight Senvice Post-Flight Senvice
Quality
Air Trawel
Semice

In-Flight Service

This diagram contains mare detail than is curently shown.

Figure 18.35. Branch-Level Diagram
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Then, at the next stage of your presentation, dynamically foliate the branches with
stems, as follows:

W SAS [_ O] x]

Elle Edit Yiew Tools Solutions Window Help

“Ishikawa-SASUSER.ISHPLANE [_[O]

Pre-Flight Service

Post-Flight Service

Cuality
Ajr Trawvel
Senvice
Undelete
Unsubset
Unbalance
< Detail
In-Flight Service Fiefresh
Increase level of detail v
Figure 18.36. Increasing the Level of Detalil
The amount of detail is increased by one level.
¥ 5A5 [_[Ofx]
Elle Edit Yiew Tools Solutions Window Help k
-~ Ishikawa-SASUSER.ISHPLANE [_[O]x]
Pre-Flight Service Post-Flight Service
Quick
Nearby gates ConvenienF deplaning
Winirmurm deparure times Baggage
connections Cluick securty
Advance boarding licketing . (_Zonnect!ng
" flight infarmation
passes Cormpetitive Nearkry
Frequent flier fares exits
counesies Mo Gates accessible
overbooking 1o non-ticketad Quality
Ajr Trawvel
Senvice
Flight
attendants Cormiortakle
seating
Mechanical
Meals

Entertainment

In-Flight Service

Figure 18.37. Increasing the Level of Detalil
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Zooming Arrows

A second method for managing a highly detailed Ishikawa diagram is to work with
a subsection of the diagram in a separate window. The window and the sub-arrows
inside it can be resized independently of the parent window. In all other respects, the
information in the two diagrams is linked dynamically. Changes in one window (for
instance, moving, adding, and editing arrows) are reflected in the other window.

To zoom an arrow, proceed as follows:

e Move the cursor over the arrow head.
¢ Activate the popup menu using the right mouse button.

e Selec{Zoom|.
To return orunzoomselecFile > | .

You can have up to four windows open at one time.

To reduce the amount of window management, you can specify that zoomed diagrams
are to be displayed in the current window rather than in new windows by setting
Zoom Window to Currentin the|View > | Ishikawa Settings>|[Other...| dialog.

Example

The following figure shows a branch labeléatFlight Serviceafter it has been
zoomed into a new window:

W SAS

= E3
File Edt Yiew Tools Soluions Window Help
“* Ishikawa-SASUSER.ISHPLANE [_To[x]
Adtentive Helpful
Flight ! -~
aftendants i Fullsize Armple
pillowes leg room
Courteous / i/ Comfartable
7 7 seating
Clean Ample
elbow room
Comfortable
cabin temp
Mechanical L 7 7
Srmooth rice Srnooth
landing
Choice of
entrees
!
Meals
7 f
Magazines Mutriious Arnple
Entertainment ! snacks
Headsets
In-Flight Service

Figure 18.38. Zooming a Branch
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Isolating Arrows

A third method for managing a highly complex Ishikawa diagram is to view the entire
diagram as a collection of smaller diagrams. Any arrow (along with its sub-arrows)
can be isolated into a separate diagram in a new window. This diagram can then be

easily saved in a separate file.

To isolate a branch as a separate diagram, do the following:

e Move the cursor over the head of the arrow.
¢ Activate the popup menu using the right mouse button.

e Selecilsolate].

You can have up to four ISHIKAWA windows open at one time.

Example
Consider the following diagram:

W 5a5 =1 3
Fle Edt View Took Soltions ‘Window Help

* Ishikawa-SASUSER.ISHPLANE M= B

Pre-Flight Service Post-Flight Service
i
Cuick
Mearhy gates Convenient deplaning
Winirmurm departure times Baggage
connections Cuick, SECUrity
Advance boarding ticketing Connecting
flight information
passes Competitive Mearksy
Frequentflier fares exits
courtesies Mo Gates accessible
overhoakin 1o non-ticketed Cluality
Air Travel
Attentive Helpful Full-size Ample Service
Flight pillowes leg room
attendants Comtartahle
Comfartable Courteous seating
sabin temp Clean Ample
Mechanical Choice of  €lbow room
entrees
e Jmooth fide  Smooth
Magazines Janding Weals
Enftertainment Mutitious  Ample
Headsets X X snacks
In-Flight Service
i
A

Figure 18.39. A Highly Detailed Diagram

To isolate the branch labeldd-Flight Serviceas a separate Ishikawa diagram, move
your cursor over the head of the arrow. Use the right mouse button to activate the

popup menu and selgtsblate] .
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The following figure shows the main diagram in one window and the branch labeled
In-Flight Serviceafter it has been isolated to another window:

¥ 5aS
Fle Edit View Tools Soluions Window Help

“ Ishikawa-SAS USER.ISHPLANE =] 3

Flight
attendants

Entertainmernt Mechanical

Attentive

. Comfartable
Magazines cahintemp

Srnooth ride Courteous

Headsets

Smooth  Helpful
landing

In-Flight Service

Mutritious

Choice of
entrees

Full-size
pillows
Ample

elbow room
Ample
leg room

Cortartable
seating

Figure 18.40. Promoting a Branch into a New Diagram

To return to the original diagram, selfte | Close] .

Merging Diagrams

You can combine multiple Ishikawa diagrams intanasterdiagram by using the

merge operation. To merge a stored diagram into the current diagram, proceed as
follows:

« SelecfFie | Ferge]

e Specify the name of a SAS data set that contains a saved Ishikawa diagram.

Another way to combine diagrams is to open separate ISHIKAWA windows for each
sub-diagram then copy them into the master diagram. To copy all or part of an
Ishikawa diagram from one window to another, do the following:

e Move the cursor over the head of the arrow.
¢ Activate the popup menu using the right mouse button.

° Selec )

e Position the cursor slightly to one side of the new attachment point and click
(just as though you are adding a new arrow).
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Example
Suppose you want to create the following diagram by combining information from
diagrams already created by each of the major service areas (Pre-Flight, In-Flight,
and Post-Flight) and stored in different SAS data sets:

W 5AS [ (O] <}
Fle Edt Miew Took Sollions Window Help
- T Ishikawa-SASUSER.ISHDOC [ [O]x]

Pre-Flight Service | Post-Flight Service

CQuality
Air Travel
Senice

In-Flight Service

Y

This diagram contains more detail than is cunently shown,

Figure 18.41. A Completed Master Diagram
First, use the ISHIKAWA environment to create the trunk for the new master diagram.

W 5AS (O] x]

Fle Edt Miew Took Sollions Window Help

* Ishikawa-SASUSER.ISHPLANE M= B
Cluality
— Air Travel
Service

Y

Figure 18.42. Starting a Master Diagram
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SelecfFile »|[Merge] from the command bar to open the File Requestor dialog.

Select an input data =et, i[jl gl
Libraries Sazhelp pen |
(2P Maps tMaps

(2] Sashelp (5P Sasuser Cancel |
[z Sasuser ok

(B Work

tdember Marne: ||

kol Tupa |Data Tables DATA) =]

Figure 18.43. Member Selector
Specify the name of the data set fre-flight serviceand presfpen] .

Now click on a point along the trunk where this sub-diagram is to attach.

W SAS M=l

Eile Edit View Tools Soluions Windaw Help

“-Ishikawa-SASUSER.ISHPLANE =] 3

Pre-Flight Service

Quality
Ajr Trawvel
Senvice

Figure 18.44. Constructing a Master Diagram
To complete the diagram, repeat the process for the remaining branches.

565
SAS OnlineDocl]: Version 8



Part 4. The CAPABILITY Procedure

Creating Graphics Output Using SAS/GRAPH Software

One way to create a hard copy of your Ishikawa diagram is to send it to a graphics
device using SAS/GRAPH software. To do this, you should submit a GOPTIONS
statement to direct the graphics output to the appropriate location and control the out-
put formatbefore you invoke the ISHIKAWA environmérr example, the following
GOPTIONS statement directs the output to a PostScript device:

goptions target=psl noprompt;

If you do not specify a target device before invoking the ISHIKAWA environment,
you will be prompted for one before the graph is generated.

In the ISHIKAWA environment, when you are ready to route your out-

put to a hard copy device, seleffile~| [Saveas-| [Graph| . This opens
a dialog that enables you to customize various aspects of your graph.
Primary Font: BIMPLEX [
Height: 3.02 [
Secondary Font: SIMPLEX [
Height: 3.02 u

Color Options

TFill Text Boxes

¥ Draw Shadow

¥ Use Background Color
[T Switch BLACK and WHITE

Saue...l M Eancell He]pl

Figure 18.45. Hard Copy Requestor

To save the diagram to the default graphics catalog in the WORK library
(WORK.GSEG), simply presK| and close the dialog. The default member
name is ISHIKAWA.

To save the diagram to a different graphics catalog, s{dee..| and then use the
Member selector window to specify a library, a SAS catalog, and a member name.

When sending a diagram directly to an output device, you can ignore the member
name entirely.

To save to your own graphics catalog, se and then use the Save a member
selection window to specify a catalog and data set name. Simply @clwhen

you want to save your diagram to the default graphics catalog (WORK.GSEG). When
sending a diagram directly to an output device, you carfausg.

You must specify two SAS/GRAPH fonts for drawing the labels in the hard copy of
the diagram. The hardware fonts used in the ISHIKAWA environment cannot be used
for your hard copy. Therimaryfont and size are used for the first three levels of text.
Thesecondaryfont and size are used for the remaining levels of text.

To change fonts, enter a valid SAS/GRAPH font name in the font field or click on the
button to the right of the font field to display a font requestor dialog. The default font
is SIMPLEX.
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You can specify the height of the text directly in the height field (in screen percent
units), or you can click on the button to the right of the field to requestlemolute
height or arelative height.

¥ sas =

Fle View TIods Solutons Window Help

Pre-Flight Service I
Graphics Options Requestor

Ishikawa-New

Post-Flight Service

Primary Font: SIMPLEX [
Height: 2.63 | ol O
Fares i
Secondary Font: SIMPLEX "
Height: 2.23 I Felative

Color Options Baggage
CFill Text Boxes
¥ Draw Shadow
¥ Use Background Color
[ Switch BLACK and WHITE
|

Save. .. | M Cancel | Help

Quality
Air Trawel
Semice

Flight attendants

Meals

Entertainment

In-Flight Service

Use absalute font height 4

Figure 18.46. Font Height Selector

SelectAbsolute] when you want the font height in the output to be the same height
as the font height used in the ISHIKAWA environment even if the output window
and the ISHIKAWA window differ in size. SelefRelative] to maintain the same
font height to window size proportion in both the ISHIKAWA window and the output
window. The numeric value entered in the height field after either choice is a screen
percent unit. The default text heightabsolute

Use theb Fill Text Boxes| andlo Draw Shadow| check boxes to suppress the box fills
and box shadows from the output. They cannot be usedddhese features to the
hard copy if they were not present in the ISHIKAWA window.

Use theo Use background colof check box to indicate whether the background color
from the ISHIKAWA environment is used in the output. This option is useful when
you are sending your diagram t@alor device and you want the background in your
hard copy to match that of your ISHIKAWA environment.

Use thee Switch Black and White| check box to interchange black and white when
the diagram is sent to the output device. This option is useful when you send your
diagram from a white-on-black display to a black-on-white hard copy device.

Click on[OK | to generate the hard copy output or click[@ancel| to quit.
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Creating Bitmap Graphics Output

A second way to create a hard copy of your Ishikawa diagram is to export it as a
bitmap to one of the following:

¢ the host graphical clipboard
e an external bitmap file
¢ a SAS/GRAPH Image catalog entry

To copy the Ishikawa diagram as a bitmap to the host clipboard,
. The results are host specific. For more details about copying to the host clipboard

on your system, consult the SAS companion for your host.

To export the Ishikawa diagram to a bitmap file using SAS/GRAPH software, select
[File > |[Export as Bitmap v |[File...| .

Export HE

Save jn; I _4 My 5AS Files

|1 ad«1

File narme: || Save

Save az upe; IBMF' Filez [* brap] j Cancel |

Farmat:  |BMP >

Figure 18.47. Export File Requestor
The appearance of this dialog will be host specific. For more details about the format
of this dialog on your system, consult the SAS companion for your host.

To save the Ishikawa diagram as an IMAGE entry in a SAS catalog,
[Save as>|[Image] .
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Specify a graph name: Iﬁ Dl %Il
Libraries Sazhelp ﬂl
(5P Maps Maps
' Sashelp Sazuzer MI
#-(2f Sasuser (28 wark
- (2P Work
Entry Marne: ||
Entry Type: Il:atalcug IMAGE Format IMAGE] j

Figure 18.48.  Entry Selector

You must specify a SAS catalog in which to save the IMAGE entry as well as a name
for the object.

When exporting your diagram to a bitmap or saving to a SAS/GRAPH IMAGE entry,
you can have the colors mapped so that color diagrams are saved in black on white or
white on black. You do not have to make those changes to the diagram yourself. Use
[File > |[Export as Bitmap = ||Customize..]| to display the following dialog:

™ Black on a white background
= “white on a black background

Cancel |

Figure 18.49. Customize Export Dialog

Select Black on white| to convert the output to a black diagram on a white back-
ground. This is useful when the diagram is being exported to a document.

Selecto White on black]| to convert the output to a white diagram on a black back-
ground. This is useful when the diagram is being exported for display on a black and
white terminal.
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Modifying Fonts

By default, the ISHIKAWA environment uses the same hardware font as the SAS
Display Manager. However, you have the option of specifying two different font
styles/sizes.

The primary font is used for labeling arrows in the first three levels of the diagram.
The secondaryfont is used for labeling arrows in the remaining levels. You will
typically use a smaller font in the detailed (secondary) areas of the diagram.

To change a font, sele@tiew »| [Ishikawa Settings> | |[Primary Fonts...| or |View b |
[shikawa Settings>| [Secondary Fonts.| to display the Font Requestor window, as
follows:

Faont gtyle:

|F| egular

Raoman

T 545 Monospace

T 545 Monospace Bold
Sasfont =

Script:

IWestern LI

™ Default System Fort

Figure 18.50. Font Requestor

The layout of the Font requestor window is host specific. Typically, it will contain a
list of available fonts and sizes displayed in a scrollable region. Refer to your host
documentation for specific information regarding the format of this dialog.

To change fonts, select a font from the list.

You must close the Font Requestor window before you can proceed. B#etd
apply the font ofCancel| to cancel the dialog.

To customize your session so that these fonts are permanently associated with the
ISHIKAWA environment, selegView > |Save Attributes| from the command bar.
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Modifying Box Colors

By default, the box fill (background) color is empty and the shadow (outline) color is
the same as the arrow color.

To modify the colors associated with trunk and branch boxes, seleoto|
Ishikawa Settings>|[Colors...| . A dialog, similar to the following, is displayed:

Customize Colors E3

Shadnwl
Text |
L 1

jEﬂ Eancell He]pl

Figure 18.51. Colors Dialog
To change the fill color of all the boxe# the Ishikawa diagram, do the following:

e Select a color from the color palette.

° Selec )

Once modified, the fill color is unaffected by changes in the arrow color. To return
the box to an empty fill, proceed as follows:

e Select the current infill color from the color palette (if it is not already the
current color).

° Selec )

To change the shadow color of the boxes, s¢beidow| and follow the same proce-
dure.

Selec{OK | to close the dialog to cancel the changes.

*You cannot directly modify the colors of individual boxes from this dialog.
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Modifying Arrow Colors and Line Styles

The ISHIKAWA environment provides aline style palette and a color palette that you

can use to customize the arrows in your Ishikawa diagram. Palettes

to activate both palettes.

W 5AS (O] x]

e View Took Solions Window Help

Ishikawa-SASUSER.ISHDOC

]

Stf]e Width pemnice

—— Boarding pa&es

Post-Flight Service

Exits

Baggage

Cuality
Air Travel
Service

Flight
attendants

Meals

Entertainmert

In-Flight Service

Figure 18.52. Line Style and Color Palettes

To specify the arrows to which color and line selections apply, subset them with the

subset function. To toggle an arrow in or out of the list of subsetted arrows, do the
following:

e Use the right mouse button to display the arrow head or the arrow tail popup
menu. To subset an arrow and all its descendants, use the arrow head popup

menu. Use the arrow tail popup menu to subset an arrow without any descen-
dants.

° Selec )

The labels of all subsetted arrows are underlined.

On some hosts, shift-clicking on the arrow head or tail will also subset the arrow. You
can subset any combination of arrows in the diagram.

You can change the color of all the subsetted arrows by selecting the desired color in
the color palette with the mouse. Likewise, use the line palette to control the style
and width of the arrows.

*If you are working on a black-and-white terminal, you should not use the color palette.
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To unsubset all the arrows in the diagram, do the following:

¢ Move the cursor to dackgroundarea of the ISHIKAWA window.
¢ Use the right mouse button to activate the background popup menu.

e SeleciUnsubsef from the popup menu.

To unsubset a specific arrow in the diagram, seSedisef from the context-sensitive
popup menu for the arrow head or tail.

Be sure to remove all subsets once you have finished modifying the diagram, since
subsets affect the focus of many other operations.
Example

Continuing with the diagram from the previous section, subset the trunk using the
arrow tail popup menu.

¥ 5AS HEE
Fle Edit View Tools Soluions Window Help

> Ishikawa-SASUSER.ISHDOC

Pre-Flight Service

Post-Flight Service

Fares

Boarding passes Baggage

Quality
Air Trawel
Senice

]

Balance

Flight
attendants

Swap
Copy

Entertainment

In-Flight Service

Tag an arrow far action

Figure 18.53. Subsetting Only the Trunk
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Note that only the trunk is subsetted (as indicated by the underlined label).

W 5AS (O] x]
Fle Edt Wiew Iook Sobdions window Help

“* Ishikawa-SASUSER.ISHDOC M= B

Post-Flight Service

Pre-Flight Service

Fares

Baggage

Boarding passes

Quality
Alr Trawel
Service

Flight
attendants

Meals

Entertainmernt

In-Flight Service

Y

Figure 18.54. Subsetting Only the Trunk (continued)
When you select a line style from the line palette, only the line style of the subsetted
arrow is changed.

W SAS [_ O] x]

Elle Edit Yiew Tools Solutions Window Help

“-Ishikawa-SASUSER.ISHDOC [_[O]x]

FPost-Flight Service

Pre-Flight Service

Exits
Fares

Boarding passes Baggage

Quality
IR nnnnnnnnnnnnnnn IIIIIIIIIIIIIIIII) Air Trawvel
Service
Flight
attendants
Meals
Entertainment

In-Flight Service

Figure 18.55. Modified Diagram
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Alternately, if you subset the trunk using the arrow head popup menu, all of the
arrows in the diagram are subsetted.

W SAS

= E3
Eile Edit View Tools Soluions Windaw Help
= Ishikawa-SASUSER.ISHDOC [_ O[]
Pre-Flight Service Post-Flight Service
Fares
Boarding passes Baggage
Cuality
Balance:
Flight Swap
attendants
Copy
Meals
Entertainmert
InFlight Service
Tag an arrow for action v
Figure 18.56. Subsetting the Entire Diagram
Note that all of the labels in the diagram are now underlined.
¥ 5AS [_[O1x]
Eile Edit View Tools Soluions Windaw Help
= Ishikawa-SASUSER.ISHDOC [_ O[]

Fre-Flight Service Fost-Flight Service

Fares

Boarding passes Baggage

Quality
Alr Travel
Service

Elight
attendants

Meals

Entertainmet

In-Flight Service

Figure 18.57.  Subsetting the Entire Diagram (continued)
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Now, when you select a new line style from the line palette, all the arrows are drawn

with this line style.

¥ 5A5 [_ (O] ]
Elle Edit Yiew Tools Solutions Window Help
- Ishikawa-SASUSER.ISHDOC [_[O]x]
Pre-Flight Service PostFlight Service
i i
] "
. .
. '
B B
| I >
3 )
Faregs -------------- > |
‘\
M .
W Boarding passes W Baggage
|
. '
\‘{ \:‘ Quality
IR nnnnnnnnnnnnnnn IIIIIIIIIIIIIIIII) Air Trawvel
A Service
{
)‘( ______________ Flight
N attendants
J
J
Meals -------------1 >
f
J
B S Entertainment
In-Flight Service
i
7

Figure 18.58. Modified Diagram

To remove the subset from thHere-Flight Servicebranch and all its descendants,

seleciSubsef from the arrow head popup menu.

W 5a5 =1 3
Fle Edt View Took Soltions ‘Window Help
“* Ishikawa-SASUSER.ISHDOC M= B
Pre-Flight Service Past-Flight Service
i i
B Exits -------------- >
Fares -------------- > "
\( 77777777777777 Boarding passes SRR Bagoage
U . Quality
IIIIIIIIIIIIIIIIIIIIIIIﬂm'IIIII)I‘IIIIIIIIIIIIIIIIIIIIIIIIII\{IIIIIIIIIIIIIIIII) Air Travel
Balance / Senvics
Swap j< ______________ Flight
Copy i attendants
teal Zoom -
Isolate J
R G Entertainmernt
In-Flight Service
i
Tag an anow for action 4

Figure 18.59. Selectively Removing Tags
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This removes the underlines from the labels in these arrows.

W SAS H=] 3
File Edt Yiew Tools Soluions Window Help
> Ishikawa-SASUSER_ISHDOC [_To[x]
Pre-Flight Service Post-Flight Service
i i
xitg -------------2 >
Fares -------------- > |
\',( 77777777777777 Boarding passes “,( """"""" Baggage
. . Quality
IIIIIIIIIIIIIIIIIIIIIIYIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII”IIIIIIIIIIIIIIIII) Aijr Travel
A Senice
;( ______________ Elight
; attendants
Meals -------------- >
;‘( -------------- Entertainrment
In-Flight Service
i
4

Figure 18.60. Selectively Removing Subsets (continued)

You can now use the line palette to change the line style for all the arrows in the
diagram with the exception of tHere-Flight Servicebranch and its descendants:

¥ 5AS = E3
Eile Edit View Tools Soluions Windaw Help
- Ishikawa-SASUSER_ISHDOC [_[O]x]
Pre-Flight Service Fost-Flight Service
0
.

"( -------------- Boarding passes Boggage

Quality
Air Travel
Service

Elight
attendants

Entertainment

In-Flight Service

Figure 18.61. Modified Diagram

The same principles apply when making color changes—simply use the color palette
instead of the line style palette.
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Modifying Text Colors

By default, labels have the same color as the arrow. To modify the text color in-
dependently of the arrow color, sel¢dgiew > | lshhikawa Settings> | [Colors...| . The
Customize Color window, similar to the following, will open:

Customize Colors
Shaduwl
Text |
R
DKl Cancell Helpl

Figure 18.62. Colors Dialog
To change the text color of all the arrofnis the Ishikawa diagram, do the following:

e Select a color from the color palette.

° Selec )

Once modified, the text color is unaffected by changes to the arrow color. To relink
the text color to the arrow color, do the following:

e Select the current text color from the color palette (if it is not already the current
color).

¢ SelecfText]

Selec{OK | to close the dialog window. To cancel the changes, sigaote] .

*You cannot directly modify the text color for individual arrows from this dialog.
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Modifying Arrow Heads

To modify the characteristics of the arrow heads in your diagram, sgieat>
Ishikawa Settings>||Arrows...|. This opens the following dialog:

Style & Tapered
Flu=sh
" Empty
Length ﬂ J ﬂ
Width 4] | ]
Dizplay ﬂ J ﬂ
ﬂ Cancel | Help |

Figure 18.63.  Arrows Dialog

The dialog controls the characteristics of all arrow heads. Arrow heads cannot be
modified individually.

Arrow heads can be tapered, flush, or empty. Use the sliders labelegth and
Width to control the length and width of the arrow heads. Move the sliders to the
right to increase the length/width of the arrow head and to the left to decrease the
length/width.

Removing arrow heads increases the readability of a highly detailed diagram. Use
the Display slider to control the level at which arrow heads are displayed. Move the
slider to the extreme left to remove all the arrow heads and to the extreme right to
display all the arrow heads. Use the intermediate settings to select a threshold level
of detail, above which arrow heads are not displayed. By default, arrow heads are
displayed for all levels.

Selec{OK | to close the window. To cancel the changes, séfegicel .
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Modifying Environmental Attributes

You can modify other features of the ISHIKAWA environment such as zooming,
mouse sensitivity, and shadow attributes by seledifieyv > | [Ishikawa Settings» |

to open the following dialog:

Zoom Window ( Current * New

Shadow Type {( Bevel 1 * Drop
" Bevel 2 " None
Shadow Hidth il | ﬂ
fidd
Sensitivity ﬂ J ﬂ
Select

Sensitivity ﬂ J ﬂ
ﬂ Eancell He]pl
Figure 18.64. Others Dialog

Zoom Window controls whether the zoom operation opens a new window or draws in
the current window. SelegtCurrent | to reduce the amount of window management
required.

The Shadow Typebutton controls the type of shadow that is drawn around the trunk
and branch boxes.

. draws a beveled edge box with a lower-right light source.
. draws a beveled edge box with an upper-left light source.
. draws a box with a drop shadow. This is the default.

o suppresses the shadow.

The Shadow Width slider controls the shadow width if the boxes have shadows or
the outline width when boxes are displayed without shadows. Move the slider to the
right to increase the shadow width and to the left to decrease the width.

The Add Sensitivity slider controls how closely you must position the cursor to an
existing arrow before a mouse click results in an add arrow operation. Move the slider
to the right to increase the size of the context-sensitive area and to the left to reduce
the size of the context-sensitive area.

The Select Sensitivityslider controls how closely you must position the cursor to an
existing arrow before a mouse click results in an edit, delete, move, or popup arrow
operation. Operate this slider in the same manner a8dldeSensitivity slider.
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Saving an Ishikawa Diagram for Future Editing

You must save your Ishikawa diagram as a SAS data set if you intend to edit it in
the future with the ISHIKAWA environment. The ISHIKAWA environment does
not reconstruct Ishikawa diagrams by reading graphics entries (GRSEG) from SAS
catalogs.

SelectFile > |[Save As> | Data Sef| to activate the Data Set Requestor window.

Specify a data set name: @ g gl =
Libraries Sashelp Save |

Maps Maps

: Sashelp Sasuzer ﬂl

Sasuser P work

5 Work

Member Name: ||

i T [Data Tables [DATA) =]

Figure 18.65. Output File Requestor

A list of SAS librefsis displayed in the Libraries tree in the left region of the dialog.
Begin by selecting a libref from the list. A libref refers to a permanent SAS data
library located on your host system. For example, the default SASUSER libref (on
most hosts) points to a directory called SASUSER, located under the working direc-
tory of your current SAS session. Any data sets saved with the IBASUSERwill

be saved in that directory.

To direct your SAS data sets to a different directory, selectGreate new library
tool icon to open the New Library dialog. Use this dialog to specify the directory and
assign a libref to that directory.

To select the liboreBASUSER move your cursor over that entry in the list and click.
The region to the right of the Libraries tree is used to display any existing SAS data
sets in that library.

To save your diagram in an existing SAS data set, use the mouse to click on an entry
in the list. Themember naméeld will be updated to reflect your choice. If you want

to save your diagram in a new SAS data set, move your cursor tméneber name

field and type the new name (in this example, SERVICE).

SelecfSave to save the diagram and return to the ISHIKAWA environment or select

to cancel the save.
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Reading an Existing Ishikawa Diagram

To enter the ISHIKAWA environment and resume editing an existing diagram, you
must have previously saved the diagram as a SAS data set. The ISHIKAWA environ-
mentdoes notallow you to modify graphs stored in SAS/GRAPH catalogs.

You can specify the name of this data set when you establish the ISHIKAWA envi-
ronment with the following statements:

proc ishikawa data=libref.dataset;
run;

Alternatively, the ISHIKAWA environment will prompt you for a data set after you
invoke the environment with the following statements:

proc ishikawa;
run;

When you specify a data set in the PROC statement, the ISHIKAWA environment is
initialized and your diagram is displayed up to the branch level. The message area
will indicate if any additional detail is hidden. You can edit your diagram even if
some of the diagram is hidden. To add or remove detail one level at a time, select
[> Detail| or|< Detail| from the background popup menu.

When you do not specify a data set in the PROC statement, you will see the following
menu:

Ishikawa Procedure [ x|

Edit an Existing Ishikawa Diagraml

Help |

Quit |

Figure 18.66. Initial Menu
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Since you are editing an existing diagram rather than starting a new diagram, select

[Edit an Existing Diagram | to activate the Member Selector window.

Select an input data =et, @
Librariez Sazhelp
Maps b aps
Sashelp Sazuzer
[EP Sasuser (P wiork

Work,

tdember Marne: |

kol Tupa |Data Tables DATA)

B

figheadishinput2lnput Member Selector

Use the Member Selector window to specify an input SAS data set. For information
on how to specify the SAS data set name, follow the steps outlined in “Saving an
Ishikawa Diagram for Future Editing” on page 581.

To establish the ISHIKAWA environment and display the diagram you have selected,
selec{Open|. The diagram is displayed up to the branch level.

To quit or start a new diagram, return to the main menu by selelCtimgel .
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Displaying Multiple Ishikawa Diagrams

The ISHIKAWA environment enables you to view multiple Ishikawa diagrams si-
multaneously for side-by-side comparisons of different diagrams. You can also use
this feature to transfer information between diagrams, since the move and copy oper-
ations function across windows. You can have up to four ISHIKAWA windows open
at one time.

To open a window for another Ishikawa diagram, sefeid > | . This will
display the Member Selector window, which you can use to specify the name of the
input SAS data set for the other Ishikawa diagram.

You can also start new diagrams while displaying other Ishikawa diagrams. To open a
window for a new Ishikawa diagram, sel¢fe | . This opens an ISHIKAWA
window with a template for a new diagram.

Example

The following figure shows an Ishikawa diagram €@uality Air Travel Servicafter
an initial brainstorming session:

W 5AS (O] x]
Fle Edt Wiew Iook Sobdions window Help

- Ishikawa-New [_[O]

Pre-Flight Senvice Paost-Flight Service

Fares

Baggage

Boarding passes

Cluality
Alr Trawel
Bervice

Flight attendants

Meals

Entertainrment

In-Flight Service

Figure 18.67.  Single Ishikawa Diagram
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The current diagram and another Ishikawa diagram can be viewed simultaneously by

selectin from the command bar.

¥ sas =

[ Edit View Tools Solions Window Help

Hﬂew... Cul+N YT =] E3

Close

Merge Pre-Flight Service Fost-Flight Service

Bavehs 3
Export as Bitmap v

f Import Data...
" Export Data...
Baggage

[=] Send Mail Boarding passes
Esit
Cluality
Air Travel
Service
Flight
attendants
Meals
Entertainment
In-Flight Service
Open an existing lshikawa diagram 7

Figure 18.68. Opening a Second Diagram

In this situation, displaying both diagrams concurrently emphasizes the improved
understanding of the process. It also enables you to transfer information from one
diagram to another.

W SAS M=l

Eile Edit View Tools Soluions Windaw Help

Ishikawa-SASUSER_ISHDOC

= Ishikawa-SASUSER.ISHPLANE

Pre-Flight Service Post-Flight Service

Fares - i
MNearby gates Quick
Convenient deplaning
Finirmurm departure times Bagoage
connections Quick . SECUty
Advance boarding ficketing Cnnnem!ng
flight information
[ passes Competithe Mearby
Frequentflier farzes exits
Ccouresies o Gates accessible
overbooking o hon-ticketed Cuality
Air Travel
Mechanical Service
Flight I

Prarmpt attendants

arrival

Meals
Cormfartable
seating Prormpt
Entertainment depanures

In-Flight Service

A

Figure 18.69. Viewing Multiple Ishikawa Diagrams
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Input and Output Data Sets

ISHIKAWA Procedure

The following is a complete list of the variables in output SAS data sets created by
the ISHIKAWA environment:

Variable Type Len Description

_LEVEL_ Num 8 Level of detalil

_TEXT1_ Char 40 First line of label

_TEXT2_ Char 40 Second line of label
_TEXT3_ Char 40 Third line of label
_TEXT4_ Char 40 Fourth line of label
_TEXTS5_ Char 40 Fifth line of label
_NOTE1_ Char 40 First line of note
_NOTE2_ Char 40 Second line of note
_NOTE3_ Char 40 Third line of note
_NOTE4_ Char 40 Fourth line of note
_RELPOS_ Num 8 Relative arrow position
_SIDE_ Char 1 Side arrow attaches to parent
_ANGLE_ Num 8 Angle (non-horizontal arrows)
_LWIDTH_ Num 8 Line width

_LSTYLE_ Num 8 Line style

_LCOLOR _ Char 8 Line color

_TCOLOR_ Char 8 Text color

_ICOLOR _ Char 8 Box infill color

_SCOLOR_ Char 8 Shadow color

_STYPE_ Char 1 Shadow type

_SWIDTH_ Num 8 Shadow width

_RELLNG_ Num 8 Relative length of an arrow
_HLEVEL _ Num 8 Arrow head threshold
_HSTYLE_ Num 8 Arrow head style
_HLNGTH_ Num 8 Arrow head length
_HWIDTH_ Num 8 Arrow head width
_HTEXT_ Num 8 Font height

_FTEXT_ Char 8 Font
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Only the variables LEVEL_ and_TEXTL1_ are required in the input data set for
the ISHIKAWA procedure. Each observation in the input data set corresponds to a
particular arrow in the diagram. The order of the observations is critical because it
defines the relationships of the arrows.

e The trunk is always the first observation.

e The remaining observations are ordered so that leaves are nested within stems,
stems are nested within branches, and branches are nested within the trunk.

e The variable_LEVEL_ is numeric and indicates the level within the diagram.
The trunk has a level of 0, branches have a level of 1, stems have a level of 2,
and so on.

e The firstline of text in a label is stored a3 EXTL1_, the second asTEXT2_,
and so on.

Example
The following is a partial listing of the SAS data set used to create the Ishikawa
diagram shown in Figure 18.4 on page 536:

The SAS System
Obs _level_ _textl_ _text2_ _text3_
1 0 Quality Air Travel Service
2 1 Pre-Flight Service
3 2 Competitive fares
4 2 Convenient departure times
5 2 Quick ticketing
6 2 Frequent flier courtesies
7 1 In-Flight Service
8 2 Prompt departures
9 2 Comfortable seating

Figure 18.70. Input SAS Data Set
Note the structure of this data set:

e The trunk (always the first observation) haslZ&EVEL _ value of zero.

¢ All subsequent observations for whichEVEL _ is equal to one are branches
that emerge from the trunk.

e Observations 4 and 5 are both leaves that emerge from the preceding stem
(observation 3).

e Likewise, leaves 7 and 8 emerge from the preceding stem (observation 6).

You can use this data set as a way of extracting text and notepad information from
the diagram.
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Syntax

There are only three options that can be specified in the PROC ISHIKAWA statement,
since the ISHIKAWA procedure is primarily a user-driven procedure.

DATA=SAS-data-set
identifies the name of a SAS data set that specifies an existing Ishikawa diagram. By
default, the procedure will prompt you to edit an existing Ishikawa diagram or start
a new one. When you specify the DATA= option, the procedure bypasses this initial
menu. For example, the following statements simplify editing an existing Ishikawa
diagram saved in a SAS data set:

proc ishikawa data=work.airline;
run;

NEW
starts a new Ishikawa diagram. By default, the procedure will prompt you to edit an
existing Ishikawa diagram or start a new one. When you specify the NEW option, the
procedure bypasses this initial menu and starts with a new diagram. Do not specify
any other options when using the NEW option. For example, the following statements
simplify starting a new Ishikawa diagram:

proc ishikawa new;
run;

NOFS
allows you to create hard copies of Ishikawa diagrams saved as SAS data sets without
invoking the interactive features of the procedure. You must specify the DATA=
option when you use the NOFS option. For example, the following statements create
a hard copy of the Ishikawa diagram saved in the SAS dataadtairline

goptions dev=ps|l noprompt;
proc ishikawa data=work.airline nofs;
run;
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Examples

Example 18.1. Quality of Air Travel Service

Output 18.1.1 on page 590 illustrates factors affecting the quality of air travel sefS&aSHPLANE
in the SAS/QC
Sample Library

Example 18.2. Integrated Circuit Failures

Output 18.2.1 on page 591 illustrates common sources of failure in integrate@esfSHCHIP
cuits in the SAS/QC
' Sample Library

Example 18.3. Photographic Development Process

Output 18.3.1 on page 592 depicts the various stages of the photographic def
ment process and specific quality control points. g‘;rfr‘]e iALiSé%?
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Quality of Air Travel Service

Output 18.3.1.
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Common Causes of Integrated Circuit Failure

Output 18.3.2.
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Photographic Development Process

Output 18.3.3.
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